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Introduction

This example shows how to make a simple model for a binary distillation process by 
combining functionality in the Thermodynamics node, available when licensed to the 
Chemical Reaction Engineering Module or the Liquid and Gas Properties Module, and 
the Transport of Concentrated Species interface. In this model the separation of a non-
ideal mixture of ethanol and water is studied. The required equilibrium relationship is 
generated using the Equilibrium Calculation functionality available when using the 
Thermodynamics node. The model is used to find the optimal design of the column in 
terms of the length of the stripping and rectifying sections to meet a set of specified 
distillate and bottoms compositions.

Distillation Background

Distillation is the most prominent separation method in chemical process industries. In a 
typical application, as shown in Figure 1, a liquid mixture of two or more species is fed into 
a tall cylindrical column somewhere near the middle. For the purpose of illustration, this 
example is limited to two species. There is a heat source in a collecting vessel or column 
section at the bottom of the column called the reboiler. Liquid from the feed runs down 
the column and is heated and partially vaporized in the reboiler. Normally, some of the 
liquid in the reboiler is continuously removed as the bottoms product. The vapor 
generated in the reboiler rises up toward the top of the column, where it is condensed in 
an externally cooled vessel or column section called the condenser. Some of the condensed 
liquid in the condenser is normally removed as the overhead product or distillate. The 
remainder of the condensed liquid is sent back down the column as reflux. With heat 
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added at the bottom and removed at the top, the temperature decreases from bottom to 
top of the column that operates at nearly constant pressure.

Figure 1: Packed distillation column schematic.

The separation process inside the column is governed by the difference in tendency to 
vaporize, or volatility, of the two species. Generally, the species with the lower boiling 
point will vaporize easier and concentrate in the vapor phase. As the liquid flowing down 
the column contacts the vapor rising up, mass transfer occurs between the phases as each 
species seeks to reach chemical equilibrium. The equilibrium condition dictates the relative 
amounts, or composition, of each species that would be in each phase at equilibrium at a 
certain temperature and pressure. The vapor phase will have a higher composition of the 
more volatile species at every point in the column.   As the vapor phase rises up the column, 
the equilibrium composition shifts (with decreasing temperature) to drive the vapor phase 
toward purity in the more volatile component. Similarly, the liquid phase flowing down 
the column is driven toward purity in the less volatile component.

Inside, the column will have one of two types of internals designed to provide intimate 
contact between the vapor and liquid phases and facilitate their approach to equilibrium.   
The column will either contain a series of stages or be filled with a specialized packing. A 
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staged column contains a number of horizontal plates or trays with liquid flowing across 
while vapor bubbles through. In an idealized column, the liquid flowing down after 
crossing a stage will be in equilibrium with the vapor rising up from that stage. A packed 
column will contain one or more sections of random or structured packing material made 
of metal, ceramic, or plastic in specialized shapes. Void spaces inside and between the 
packing particles allow for high fluid flow rates with limited pressure drop. Ideally the 
packing is wetted with a thin film of liquid with vapor flowing past the liquid film with a 
high surface area to promote mass transfer between the phases.

In practice, chemical equilibrium will not be reached due to mass transfer limitations and 
with finite column height the distillate and bottoms products will not be completely pure.   
More stages or a larger height of packing in a column will provide higher purity products, 
but will require a taller, more expensive, column. For a given column height, a higher 
reflux will provide higher product purity, but will yield a lower distillate product flow rate 
and will require a larger diameter column to accommodate the increased internal flow.

Model Definition

As in virtually all chemical processes, analysis and design of a distillation column requires 
a combination of mass balances, energy balances, equilibrium relationships, and rate 
equations. This example considers binary distillation with a saturated liquid feed in a 
packed column and makes use of two common simplifying assumptions:

• The molar heats of vaporization of the feed species are equal.

• The heat loss from the column and other heat effects, like heat of solution, are 
negligible.

These assumptions let us model the process without considering heat effects or energy 
balances. They also dictate that the liquid and vapor molar flow rates are constant in each 
column section, the so called stripping section below the feed and the so called rectifying 
section above the feed location. That is, for every mole of liquid evaporated within the 
column, a mole of vapor is condensed. This assumption is known as constant molar 
overflow and is not as unrealistic in practice as it may seem (Ref. 1).

Considering a saturated liquid feed means that all of the feed joins the liquid in the 
stripping section such that 

 (1)

Here Ls is the liquid flow rate from the stripping section into the reboiler, Lr is the liquid 
flow rate from the condenser into the rectifying section, and F the feed flow rate. Other 

Ls Lr F+=
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feed conditions would alter the analysis slightly since some or all of the feed would join the 
vapor phase in the rectifying section under other conditions. 

The column design task considered here is to determine the height of packing and feed 
location required to separate a feed of known flow rate and composition into distillate and 
bottom streams of specified purity. Additional process parameters to be specified include 
the boil-up rate, or vapor molar flow rate within the column, and the overall gas phase 
mass transfer coefficient, Kya. In practice, the boil-up rate will depend on the heat input 
to the reboiler. We specify the boil-up rate as 

 (2)

That is, the vapor flow rate from the reboiler into the stripping section equals the vapor 
flow rate into the condenser.

Overall and species mass balances allow us to calculate the molar flow rates of our bottoms, 
B, and distillate, D, by solving two equations in the two unknowns:

 (3)

 (4)

where xf, xb, and xd are mole fractions of the more volatile species in the feed, bottoms, 
and distillate streams, respectively.

The internal liquid flows are then found from:

 (5)

along with Equation 1. All of these flow rates are found in the model by algebraic 
manipulation in the Parameters node under Global Definitions in the Model Builder Window.

Neglecting any variation in the radial direction, we model the distillation column in one 
dimension using two line segments (see Figure 2). One segment of length, Hs, represents 
the stripping section, while the other segment of length Hr, represents the rectifying 
section. The goal of the model is to determine the values of Hs and Hr that provide the 
specified bottoms and distillate compositions. We assume values of Hs and H = Hs + Hr, 
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solve for the compositions in the vapor and liquid phases at every point in the column, and 
iterate until the outlet compositions match the design specifications.

Figure 2: One dimensional model geometry including the boundary conditions for the mole 
fraction of ethanol in each phase.

To solve for the mass transfer we use two instances of the Transport of Concentrated 
Species Interface, one for the vapor phase and one for the liquid phase. The mass transfer 
between the phases is accounted for as using a Reacting Source node where the source rate 
is defined as 

 (6)

where Kya is an overall gas phase mass transfer coefficient in mol/(m3·s), ye1 is the mole 
fraction of the more volatile species that would be reached at equilibrium, and M1 is the 
molar mass of the more volatile species. This provides a mass transfer rate of the more 
volatile species from the liquid phase to the vapor phase. A similar expression with opposite 
sign describes the simultaneous mass transfer of the less volatile component in accordance 
with our constant molar overflow assumption. The value of ye1 at each point is found 
using an Equilibrium Calculation node added in the Thermodynamic system under 
Thermodynamics. The mass transfer coefficient will depend on the fluid and packing 
properties and the local fluid velocities and may vary along the height of the column. 
Correlations for Kya are available in the literature. In this example we assume a constant 
value of Kya = 75 mol/(m3·s) for illustrative purposes.

The molar flows of liquid and vapor within the column are accounted for by specifying the 
velocity in each phase. In this lumped parameter model based on an overall gas phase mass 
transfer coefficient, we use an equivalent gas phase velocity for the liquid phase to put them 
on the same basis. This is essentially a form of scaling the liquid phase velocity to be on the 
same order of magnitude as the gas phase velocity. To convert a molar flow rate, Lr for 
example, to a velocity, uLr, we assume a column diameter, determine a cross-sectional area, 
A, and assume ideal gas molar volume at standard conditions for both phases:

 (7)

Vapor phase inlet = xb Vapor phase outlet

Liquid phase outlet Liquid 
phase inlet = xdLiquid phase feed = xf

Stripping section Rectifying section

R1 Kya ye1 y1–( )M1=

uLr
Lr0.022414 m3/mol

A
-------------------------------------------------------=
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The boundary conditions for our mass transfer problem are shown in Figure 2. We specify 
the mass fraction of the bottoms in the vapor phase and the mass fraction of the feed and 
distillate in the liquid phase. Hs and H are varied by guess and check or using a parameter 
sweep until a solution is found where the liquid phase bottoms composition equals that 
specified in the vapor phase, and the vapor phase distillate composition equals that 
specified in the liquid phase.

Results and Discussion

Figure 3 shows the results of an equilibrium calculation, available in Thermodynamics, 
generating an x-y diagram for the ethanol-water system at 1 atm pressure. The NRTL 
thermodynamic model was used for the liquid phase, while an ideal gas assumption is used 
for the gas phase.

The calculated results for vapor and liquid phase compositions inside a column designed 
to separate a 50 mole percent mixture of ethanol in water to yield a distillate of 85 mole 
percent ethanol and a bottoms product of 5 mole percent ethanol are shown in Figure 4. 
The required heights found by trial are Hs = 1.3 m and H = 12 m. In the model a 
Parametric Sweep study step was used to compute the column composition when varying 
the stripping section length. The design criteria to be met in this case is that the ethanol 
mole fraction in the vapor and liquid phase should coincide at the bottom. Using a section 
length less than about 1.3 m, the liquid phase mole fraction exiting the column is higher 
than that of the vapor phase. Correspondingly, for a section longer than 1.3 m, the liquid 
phase mole fraction is lower than that of the vapor phase. The same analysis can be made 
for the top of the column. The optimal column height is found when the phase 
compositions match also at the top. 

Figure 5 presents the results from Figure 4 on an x-y plot along with the equilibrium curve 
of Figure 3. Readers familiar with the traditional McCabe-Thiele distillation analysis will 
note that it is no coincidence that our calculated results trace out straight operating lines 
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for the stripping and rectifying sections that intersect at the feed composition for this case 
with a saturated liquid feed.

Figure 3: x-y diagram for ethanol-water at 1 atm pressure using the NRTL model.
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Figure 4: Mole fraction of ethanol in the vapor and liquid phases as a function of column 
height for a distillation column designed to separate a 50 mole percent ethanol-water mixture 
to yield products with xb = 0.05 and xd = 0.85 mole fraction ethanol. Heights required were 
Hs = 1.3 m and H = 12 m.
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Figure 5: x-y diagram showing the calculated operating lines within the distillation column 
described in Figure 4.

Reference

1. E.L. Cussler, Diffusion: Mass Transfer in Fluid Systems, 3rd ed., Cambridge 
University Press, 2009.

Application Library path: Chemical_Reaction_Engineering_Module/
Thermodynamics/distillation_column

Note: This model is included in the booklet Introduction to Thermodynamic 
Properties.
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Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 0D.

2 In the Select Physics tree, select Chemical Species Transport>Reaction Engineering (re).

3 Click Add.

4 Click Done.

R E A C T I O N  E N G I N E E R I N G  ( R E )

Species 1
1 In the Model Builder window, under Component 1 (comp1) right-click 

Reaction Engineering (re) and choose Species.

2 In the Settings window for Species, locate the Species Name section.

3 In the text field, type E.

4 In the Reaction Engineering toolbar, click Species.

Species 1
1 In the Settings window for Species, locate the Species Name section.

2 In the text field, type W.

3 In the Reaction Engineering toolbar, click Thermodynamics and choose 
Thermodynamic System.

S E L E C T  S Y S T E M

1 Go to the Select System window.

2 From the Phase list, choose Vapor-liquid.

3 Click Next in the window toolbar.

S E L E C T  S P E C I E S

1 Go to the Select Species window.

2 In the Species list, select ethanol (64-17-5, C2H6O).

3 Click Add Selected.
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4 In the Species list, select water (7732-18-5, H2O).

5 Click Add Selected.

6 Click Next in the window toolbar.

S E L E C T  T H E R M O D Y N A M I C  M O D E L

1 Go to the Select Thermodynamic Model window.

2 From the list, choose NRTL.

3 Click Finish in the window toolbar.

R E A C T I O N  E N G I N E E R I N G  ( R E )

1 In the Model Builder window, under Component 1 (comp1) click Reaction Engineering (re).

2 In the Settings window for Reaction Engineering, locate the Mixture Properties section.

3 Select the Thermodynamics check box.

4 Locate the Species Matching section. In the table, enter the following settings:

G L O B A L  D E F I N I T I O N S

Vapor-Liquid System 1 (pp1)
In the Model Builder window, under Global Definitions>Thermodynamics right-click Vapor-

Liquid System 1 (pp1) and choose Equilibrium Calculation.

S E L E C T  S P E C I E S

1 Go to the Select Species window.

2 Click Add All.

3 Click Next in the window toolbar.

E Q U I L I B R I U M  S P E C I F I C A T I O N S

1 Go to the Equilibrium Specifications window.

2 From the Amount base unit list, choose mol.

3 Find the Equilibrium conditions subsection. From the First condition list, choose Pressure.

4 From the Second condition list, choose Phase fraction.

5 Click Next in the window toolbar.

Species From Thermodynamics

E C2H6O

W H2O
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E Q U I L I B R I U M  F U N C T I O N  O V E R V I E W

1 Go to the Equilibrium Function Overview window.

2 Click Finish in the window toolbar.

G L O B A L  D E F I N I T I O N S

Analytic 1 (an1)
1 In the Home toolbar, click Functions and choose Global>Analytic.

2 In the Settings window for Analytic, type x_y in the Function name text field.

3 Locate the Definition section. In the Expression text field, type 
Flash1_1_PhaseComposition_Vapor_ethanol(p,n,x1,x2).

4 In the Arguments text field, type p,n,x1,x2.

5 Locate the Units section. In the table, enter the following settings:

6 In the Function text field, type mol/mol.

Parameters 1
1 In the Model Builder window, click Parameters 1.

2 In the Settings window for Parameters, locate the Parameters section.

3 Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
distillation_column_parameters.txt.

A D D  S T U D Y

1 In the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Physics interfaces in study subsection. In the table, clear the Solve check box for 
Reaction Engineering (re).

4 Find the Studies subsection. In the Select Study tree, select 
Preset Studies for Selected Physics Interfaces>Stationary.

5 Click Add Study in the window toolbar.

Argument Unit

p Pa

n 1

x1 mol/mol

x2 mol/mol
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6 In the Home toolbar, click Add Study to close the Add Study window.

S T U D Y  1

Step 1: Stationary
1 In the Settings window for Stationary, click to expand the Study Extensions section.

2 Select the Auxiliary sweep check box.

3 Click Add.

4 In the table, enter the following settings:

5 Click Add.

6 In the table, enter the following settings:

7 From the Sweep type list, choose All combinations.

8 In the Home toolbar, click Compute.

R E S U L T S

1D Plot Group 1
In the Home toolbar, click Add Plot Group and choose 1D Plot Group.

Global 1
1 In the 1D Plot Group 1 toolbar, click Global.

2 In the Settings window for Global, locate the y-Axis Data section.

3 Click Clear Table.

4 In the table, enter the following settings:

5 Click to expand the Legends section. Clear the Show legends check box.

6 In the 1D Plot Group 1 toolbar, click Plot.

Parameter name Parameter value list Parameter unit

n (Vapor phase fraction)

Parameter name Parameter value list Parameter unit

n (Vapor phase fraction) 0 1

x1 (Mole fraction species 1) range(0,0.01,1)

Expression Unit Description

x_y(P,n,x1,x2) 1
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7 Click to expand the Coloring and Style section. In the Width text field, type 2.

Equilibrium Curve
1 In the Model Builder window, under Results click 1D Plot Group 1.

2 In the Settings window for 1D Plot Group, type Equilibrium Curve in the Label text 
field.

3 Locate the Plot Settings section. Select the x-axis label check box.

4 Select the y-axis label check box.

5 In the associated text field, type y1.

6 Click to expand the Title section. From the Title type list, choose None.

7 Locate the Legend section. From the Position list, choose Middle right.

E Q U I L I B R I U M  C U R V E  P A R A M E T E R I Z A T I O N

1 In the Model Builder window, click Study 1.

2 In the Settings window for Study, type Equilibrium Curve Parameterization in the 
Label text field.

R E A C T I O N  E N G I N E E R I N G  ( R E )

Generate Space-Dependent Model 1
1 In the Reaction Engineering toolbar, click Generate Space-Dependent Model.

2 In the Settings window for Generate Space-Dependent Model, locate the 
Component Settings section.

3 From the Component to use list, choose 1D: New.

4 Locate the Physics Interfaces section. Find the Chemical species transport subsection. 
From the list, choose Transport of Concentrated Species: New.

5 Locate the Space-Dependent Model Generation section. Click Create/Refresh.

C O M P O N E N T  2  ( C O M P 2 )

In the Model Builder window, expand the Component 2 (comp2) node.

G E O M E T R Y  1 ( 1 D )

Interval 1 (i1)
1 In the Model Builder window, expand the Component 2 (comp2)>Geometry 1(1D) node.

2 Right-click Geometry 1(1D) and choose Interval.

3 In the Settings window for Interval, locate the Interval section.
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4 In the table, enter the following settings:

5 Click Build Selected.

Interval 2 (i2)
1 Right-click Interval 1 (i1) and choose Duplicate.

2 In the Settings window for Interval, locate the Interval section.

3 In the table, enter the following settings:

4 Click Build All Objects.

5 Click the Zoom Extents button in the Graphics toolbar.

T R A N S P O R T  O F  C O N C E N T R A T E D  S P E C I E S  ( T C S )

1 In the Model Builder window, under Component 2 (comp2) click 
Transport of Concentrated Species (tcs).

2 In the Settings window for Transport of Concentrated Species, locate the Species section.

3 From the From mass constraint list, choose wW.

Add a second Transport of Concentrated Species interface which will be used to model 
the liquid phase.

4 From the Home menu, choose Add Physics.

A D D  P H Y S I C S

1 Go to the Add Physics window.

2 In the tree, select Chemical Species Transport>Transport of Concentrated Species (tcs).

3 Click to expand the Dependent Variables section. In the Mass fractions table, enter the 
following settings:

4 Click Add to Component 2 in the window toolbar.

Coordinates (m)

0

Hs

Coordinates (m)

Hs

H

wEl

wWl
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5 From the Home menu, choose Add Physics.

T R A N S P O R T  O F  C O N C E N T R A T E D  S P E C I E S  2  ( T C S 2 )

1 In the Settings window for Transport of Concentrated Species, locate the Species section.

2 From the From mass constraint list, choose wWl.

3 In the Model Builder window, expand the Transport of Concentrated Species (tcs) node.

D E F I N I T I O N S  ( C O M P 2 )

Variables 1
1 In the Model Builder window, expand the Component 2 (comp2)>Definitions node.

2 Right-click Component 2 (comp2)>Definitions and choose Variables.

3 In the Settings window for Variables, locate the Variables section.

4 Click Load from File.

5 Browse to the model’s Application Libraries folder and double-click the file 
distillation_column_variables.txt.

T R A N S P O R T  O F  C O N C E N T R A T E D  S P E C I E S  ( T C S )

Transport Properties 1
In this model, the column temperature and pressure are assumed constant. Define these 
conditions using the Default Model Inputs node. This will make it easy to ensure that the 
same conditions are applied throughout the model.

1 In the Model Builder window, under Component 2 (comp2)>

Transport of Concentrated Species (tcs) click Transport Properties 1.

2 In the Settings window for Transport Properties, locate the Model Input section.

3 Click Go to Source for Absolute pressure for pA.

G L O B A L  D E F I N I T I O N S

Default Model Inputs
1 In the Model Builder window, under Global Definitions click Default Model Inputs.

2 In the Settings window for Default Model Inputs, locate the Browse Model Inputs section.

3 In the tree, select General>Pressure (Pa) - minput.pA.

4 Find the Expression for remaining selection subsection. In the Pressure text field, type P.

5 In the tree, select General>Temperature (K) - minput.T.

6 In the Temperature text field, type T.
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T R A N S P O R T  O F  C O N C E N T R A T E D  S P E C I E S  ( T C S )

Transport Properties 1
1 In the Model Builder window, under Component 2 (comp2)>

Transport of Concentrated Species (tcs) click Transport Properties 1.

2 In the Settings window for Transport Properties, locate the Density section.

3 From the ρ list, choose Ideal gas.

4 Locate the Convection section. Specify the u vector as

Initial Values 1
1 In the Model Builder window, click Initial Values 1.

2 In the Settings window for Initial Values, locate the Initial Values section.

3 In the ω0,wE text field, type wf.

Reaction Sources 1
1 In the Model Builder window, click Reaction Sources 1.

2 In the Settings window for Reaction Sources, locate the Reactions section.

3 From the RwE list, choose User defined. In the associated text field, type -tcs.M_wE*
Kya*(ym1-ye1).

4 From the RwW list, choose User defined. In the associated text field, type tcs.M_wW*
Kya*(ym1-ye1).

Mass Fraction 1
1 In the Physics toolbar, click Boundaries and choose Mass Fraction.

2 Select Boundary 1 only.

3 In the Settings window for Mass Fraction, locate the Mass Fraction section.

4 Select the Species wE check box.

5 In the ω0,wE text field, type wb.

Outflow 1
1 In the Physics toolbar, click Boundaries and choose Outflow.

2 Select Boundary 3 only.

uV x
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T R A N S P O R T  O F  C O N C E N T R A T E D  S P E C I E S  2  ( T C S 2 )

Transport Properties 1
1 In the Model Builder window, under Component 2 (comp2)>

Transport of Concentrated Species 2 (tcs2) click Transport Properties 1.

2 In the Settings window for Transport Properties, locate the Density section.

3 From the MwWl list, choose Molar mass (chem/W).

4 From the MwEl list, choose Molar mass (chem/E).

5 Locate the Convection section. Specify the u vector as

6 Locate the Diffusion section. In the table, enter the following settings:

Initial Values 1
1 In the Model Builder window, click Initial Values 1.

2 In the Settings window for Initial Values, locate the Initial Values section.

3 In the ω0,wEl text field, type wf.

Transport Properties 2
1 In the Model Builder window, under Component 2 (comp2)>

Transport of Concentrated Species 2 (tcs2) right-click Transport Properties 1 and choose 
Duplicate.

2 Select Domain 1 only.

3 In the Settings window for Transport Properties, locate the Convection section.

4 Specify the u vector as

Mass Fraction 1
1 In the Physics toolbar, click Boundaries and choose Mass Fraction.

2 Select Boundary 3 only.

3 In the Settings window for Mass Fraction, locate the Mass Fraction section.

4 Select the Species wEl check box.

5 In the ω0,wEl text field, type wd.

-uLr x

Species 1 Species 2 Diffusivity Diffusion coefficient (m^2/s)

wEl wWl User defined 1e-20

-uLs x
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Mass Fraction 2
1 In the Physics toolbar, click Boundaries and choose Mass Fraction.

2 Select Boundary 2 only.

3 In the Settings window for Mass Fraction, locate the Mass Fraction section.

4 Select the Species wEl check box.

5 In the ω0,wEl text field, type wf.

Outflow 1
1 In the Physics toolbar, click Boundaries and choose Outflow.

2 Select Boundary 1 only.

Reaction Sources 1
1 In the Physics toolbar, click Domains and choose Reaction Sources.

2 In the Settings window for Reaction Sources, locate the Reactions section.

3 Select the Mass transfer to other phases check box.

4 In the RwEl text field, type tcs.M_wE*Kya*(ym1-ye1).

5 In the RwWl text field, type -tcs.M_wW*Kya*(ym1-ye1).

6 Click in the Graphics window and then press Ctrl+A to select both domains.

M E S H  1

Size
In the Model Builder window, under Component 2 (comp2) right-click Mesh 1 and choose 
Edit Physics-Induced Sequence.

Size 1
1 In the Model Builder window, right-click Edge 1 and choose Size.

2 In the Settings window for Size, locate the Geometric Entity Selection section.

3 From the Geometric entity level list, choose Boundary.

4 Click in the Graphics window and then press Ctrl+A to select all boundaries.

5 Locate the Element Size section. From the Calibrate for list, choose Fluid dynamics.

6 From the Predefined list, choose Extremely fine.

7 Click Build Selected.

C O L U M N  D E S I G N

1 In the Model Builder window, click Study 2.
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2 In the Settings window for Study, type Column Design in the Label text field.

Parametric Sweep
1 In the Study toolbar, click Parametric Sweep.

2 In the Settings window for Parametric Sweep, locate the Study Settings section.

3 Click Add.

4 In the table, enter the following settings:

5 In the Study toolbar, click Compute.

R E S U L T S

1D Plot Group 8
1 In the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Settings window for 1D Plot Group, locate the Data section.

3 From the Dataset list, choose Column Design/Parametric Solutions 1 (sol3).

4 From the Parameter selection (Hs) list, choose From list.

5 In the Parameter values (Hs (m)) list, select 1.3.

Line Graph 1
1 Right-click 1D Plot Group 8 and choose Line Graph.

2 In the Settings window for Line Graph, locate the Selection section.

3 From the Selection list, choose All domains.

4 Locate the y-Axis Data section. In the Expression text field, type ym1.

5 Click to expand the Coloring and Style section. In the Width text field, type 2.

6 Click to expand the Legends section. Select the Show legends check box.

7 From the Legends list, choose Manual.

8 In the table, enter the following settings:

Line Graph 2
1 Right-click Line Graph 1 and choose Duplicate.

Parameter name Parameter value list Parameter unit

Hs (Height of stripping section) 1.2 1.3 1.4 m

Legends

Vapor phase
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2 In the Settings window for Line Graph, locate the y-Axis Data section.

3 In the Expression text field, type xm1.

4 Locate the Legends section. In the table, enter the following settings:

5 In the 1D Plot Group 8 toolbar, click Plot.

Mole Fractions
1 In the Model Builder window, under Results click 1D Plot Group 8.

2 In the Settings window for 1D Plot Group, type Mole Fractions in the Label text field.

3 Locate the Title section. From the Title type list, choose Manual.

4 In the Title text area, type Ethanol mole fraction.

5 Locate the Plot Settings section. Select the x-axis label check box.

6 In the associated text field, type Column Height (m).

7 Select the y-axis label check box.

8 In the associated text field, type x1, y1.

9 Locate the Legend section. From the Position list, choose Middle right.

10 In the Mole Fractions toolbar, click Plot.

1D Plot Group 9
1 In the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Settings window for 1D Plot Group, locate the Data section.

3 From the Dataset list, choose Column Design/Parametric Solutions 1 (sol3).

4 From the Parameter selection (Hs) list, choose From list.

5 In the Parameter values (Hs (m)) list, select 1.3.

Line Graph 1
1 Right-click 1D Plot Group 9 and choose Line Graph.

2 In the Settings window for Line Graph, locate the Selection section.

3 From the Selection list, choose All domains.

4 Locate the y-Axis Data section. In the Expression text field, type ym1.

5 Locate the x-Axis Data section. From the Parameter list, choose Expression.

6 In the Expression text field, type xm1.

Legends

Liquid phase
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7 Locate the Coloring and Style section. From the Color list, choose Black.

8 In the Width text field, type 2.

9 Locate the Legends section. Select the Show legends check box.

10 From the Legends list, choose Manual.

11 In the table, enter the following settings:

12 In the 1D Plot Group 9 toolbar, click Plot.

1D Plot Group 9
In the Model Builder window, click 1D Plot Group 9.

Global 1
1 In the 1D Plot Group 9 toolbar, click Global.

2 In the Settings window for Global, locate the y-Axis Data section.

3 Click Clear Table.

4 In the table, enter the following settings:

5 Locate the Data section. From the Dataset list, choose 
Equilibrium Curve Parameterization/Solution 1 (sol1).

6 In the 1D Plot Group 9 toolbar, click Plot.

7 Locate the Coloring and Style section. In the Width text field, type 2.

8 Locate the Legends section. Clear the Show legends check box.

9 Right-click Global 1 and choose Move Up.

10 In the 1D Plot Group 9 toolbar, click Plot.

Operating Lines
1 In the Model Builder window, under Results click 1D Plot Group 9.

2 In the Settings window for 1D Plot Group, type Operating Lines in the Label text field.

3 Locate the Plot Settings section. Select the x-axis label check box.

4 In the associated text field, type x1.

5 Select the y-axis label check box.

Legends

Column operation

Expression Unit Description

x_y(P,n,x1,x2) 1
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6 In the associated text field, type y1.

7 Locate the Title section. From the Title type list, choose None.

8 Locate the Legend section. From the Position list, choose Middle right.

9 In the Operating Lines toolbar, click Plot.
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